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Chapter 567

M-Period Cross-Over
Designs using
Contrasts
Introduction
This module calculates the power for an M period cross-over design in which the analysis is done by a testing a
user-supplied contrast. The test may be univariate or multivariate.
In a cross-over design, each subject receives a sequence of treatments and is measured at M periods. The number
of unique treatments will usually be two or three, but can be up to M. Common designs that might be analyzed by
this procedure are 3x2, 4x2, etc. The arrangement of the treatments at the M time points may be ABA, AAB,
ABB, BAA, AABB, ABAB, BBAA, ABABA, etc.
Cross-over designs are often created from Latin-squares by letting groups of subjects follow different column of
the square. The overall design is arranged so that there is balance in that each treatment occurs before and after
every other treatment an equal number of times among subject. We refer you to any book on cross-over designs or
Latin-squares for more details.
The power calculations used here ignore the complexity of specifying sequence terms in the analysis. Therefore,
the data may be thought of simply as a one-way, repeated measures design. Combining subjects with different
treatment sequences makes it more reasonable to assume a simple, circular variance-covariance pattern. Hence,
usually, you will assume that all correlations are equal.
This module calculates the power of a test of a contrast among the means in a one-way repeated measures design
using either the multivariate test or the univariate, repeated-measures F-test as described by Maxwell and Delaney
(2003) and Davis (2002).
A repeated measures design is one in which subjects are observed at a fixed set of time points. These time points
do not have to be equally spaced, but they must be identical for all subjects. A hypothesis about a contrast of the
means can be tested using Hotelling’s T2 test or the univariate F test.

Impact of Treatment Order, Unequal Variances, and Unequal Correlations
Treatment Order
It is important to understand under what conditions the order of treatment application matters since the design will
usually include subjects with different treatment arrangements, although each subject will eventually receive all
treatments. Even though the cross-over design requires a washout period between each two treatment applications
so that the effect of one treatment does not carryover to next treatment, it is always a good research practice to try
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several different treatment orders. PASS lets you study this by allowing you to set the means and standard
deviations in any order you like.
A brief investigation showed that the order of treatment application only matters when the variances at each
treatment are different. The pattern of the correlation matrix does have an impact, but only when the variances are
different.

Unequal Variances
PASS lets you investigate the impact of unequal variances on power. Of course, different variance patterns lead to
different powers. However, the special point to understand is that when the variances are different, different
treatment orders result in different powers as well.

Unequal Correlations
PASS lets you investigate the impact of unequal correlations on power. Of course, different correlation patterns
lead to different powers. However, the special point to understand is that when the variances are equal, different
treatment orders do not result in different powers. Thus, when the variances are the same, the power values for
different treatment orders will remain constant across different treatment orderings.

Conclusions
The above considerations result in the following strategy when using this procedure to power analyze (find the
sample size) for a particular design.
1. If the variance is constant across treatments, you can analyze any order and the results will stand for all
orderings. For example, for the case M = 3, there are six possible orders: ABC, ACB, BAC, BCA, CAB,
and CBA. In this case, the resulting sample size will be identical for any order.
2. If the variances are different across treatments (for example, if the variances are treatments with larger
means are assumed to be proportionally larger), you should analyze each order separately and then use the
average sample size or the maximum sample size. The point is, you cannot simply analyze one order.

Technical Details
The formulas used to perform a Hotelling’s T2 power analysis provide exact answers if the above assumptions are
met. These formulas can be found in many places. We use the results in Davis (2002). We refer you to that
reference for more details.

Technical Details for the Multivariate Test
In one-factor case, a sample of N subjects are measured at M time points. We assume that all N subjects have the
same multivariate normal distribution with mean vector µ and variance covariance matrix Σ and that Hotelling’s
T2 is used for testing the null hypothesis that ∑ 𝑐𝑐𝑖𝑖 𝜇𝜇𝑖𝑖 = 0 versus the alternative that ∑ 𝑐𝑐𝑖𝑖 𝜇𝜇𝑖𝑖 = 𝐴𝐴 ≠ 0. The value of
T2 is computed using the formula

� �2
�𝐶𝐶′𝑦𝑦
𝐹𝐹1,𝑁𝑁−1 =
= 𝑁𝑁
𝐶𝐶′𝑆𝑆𝑆𝑆
where 𝑦𝑦� is the M-dimensional vector of sample means, C is M-dimensional vector of contrast coefficients, and S is
the sample variance-covariance matrix. Rather than use the T2 distribution, we use the well-known relationship
between it and the F-distribution with df1 = 1 and df2 = (N - 1).
2
𝑇𝑇1,𝑁𝑁−1
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To calculate power we need the non-centrality parameter for this distribution. This non-centrality parameter is
defined as follows
𝜆𝜆 = 𝑁𝑁

′

�𝐶𝐶 𝜇𝜇�
′

2

= 𝑁𝑁Δ2

𝐶𝐶 Σ𝐶𝐶
We define Δ as the effect size because it provides an expression for the magnitude of the contrast of the means
under the alternative hypothesis.
Using this non-centrality parameter, the power of the Hotelling’s T2 may be calculated for any value of the means
and standard deviations. Since there is a simple relationship between the non-central T2 and the non-central F,
calculations are based on the non-central F using the formula
𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃 = 1 − 𝑃𝑃�𝐹𝐹′ > 𝐹𝐹1−𝛼𝛼,1,(𝑁𝑁−1),0 |𝐹𝐹′~𝐹𝐹1,(𝑁𝑁−1),𝜆𝜆 �

Technical Details for the Univariate Test
The univariate approach calculates an F-test for testing the hypothesis using
𝐹𝐹1,(𝑀𝑀−1)(𝑁𝑁−1) =

𝑀𝑀𝑆𝑆C
𝑀𝑀𝑆𝑆𝑇𝑇𝑇𝑇𝑇𝑇

where MSC is the mean square for the contrast (including an adjustment for the sum of squared contrast
coefficients) and MSTxS is time period-by-subject interaction mean square.
To calculate power we need the non-centrality parameter. This is defined as
𝜆𝜆 = 𝑁𝑁

′

�𝐶𝐶 𝜇𝜇�

2

= 𝑁𝑁Δ2

𝐶𝐶′Σ𝐶𝐶
where Σ meets the compound symmetry requirement defined below. We define Δ as the effect size because it
provides an expression for the magnitude of the contrast of the means under the alternative hypothesis.
PASS requires the input of σY and ρ. These can be estimated from a repeated measures ANOVA table which
provides values for MSS (mean square of subjects) and MSST (mean square of subject-time interaction). The
parameters can then be calculated as follows
𝜌𝜌� =

𝐹𝐹 − 1
,
𝐹𝐹 − 1 + 𝑀𝑀

It is useful to note the following expectations

𝐹𝐹 =

𝑀𝑀𝑆𝑆𝑆𝑆𝑆𝑆
,
𝑀𝑀𝑆𝑆𝑆𝑆

𝐸𝐸(𝑀𝑀𝑆𝑆𝑆𝑆𝑆𝑆 ) = 𝜎𝜎𝑌𝑌2 (1 − 𝜌𝜌)

𝜎𝜎�𝑌𝑌2 =

𝑀𝑀𝑆𝑆𝑆𝑆𝑆𝑆
1 − 𝜌𝜌�

𝐸𝐸(𝑀𝑀𝑆𝑆𝑆𝑆 ) = 𝜎𝜎𝑌𝑌2 (1 + (𝑀𝑀 − 1)𝜌𝜌)

The power is calculated using a formula similar to the one above based on the non-central F distribution
𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃 = 1 − 𝑃𝑃�𝐹𝐹′ > 𝐹𝐹1−𝛼𝛼,1,(𝑀𝑀−1)(𝑁𝑁−1),0 |𝐹𝐹′~𝐹𝐹1,(𝑀𝑀−1)(𝑁𝑁−1),𝜆𝜆 �
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Covariance Patterns
In a repeated measures design with N subjects, each measured M times, observations within a single subject may
be correlated, and a pattern for their covariance must be specified. In this case, the overall covariance matrix will
have the block-diagonal form:
 V1

0
V= 0
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0  0 

0  0 
V3  0  ,

   
0  VN 

0
V2
0

0

where Vi is the M x M covariance submatrices corresponding to the ith subject. The 0's represent M x M matrices
of zeros giving zero covariances for observations on different subjects. This routine allows the specification of
four different covariance matrix types: All ρ’s Equal, AR(1), Banded(1), and Banded(2).

All ρ’s Equal (Compound Symmetry)
A compound symmetry covariance model assumes that all covariances are equal, and all variances on the
diagonal are equal. That is
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where σ2 is the subject variance and ρ is the correlation between observations on the same subject.

AR(1)
An AR(1) (autoregressive order 1) covariance model assumes that all variances on the diagonal are equal and that
covariances t time periods apart are equal to ρtσ2. This choice is recommended. That is
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where σ2 is the residual variance and ρ is the correlation between observations on the same subject.
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Banded(1)
A Banded(1) (banded order 1) covariance model assumes that all variances on the diagonal are equal, covariances
for observations one time period apart are equal to ρσ2, and covariances for measurements greater than one time
period apart are equal to zero. That is
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where σ2 is the residual variance and ρ is the correlation between observations on the same subject.

Banded(2)
A Banded(2) (banded order 2) covariance model assumes that all variances on the diagonal are equal, covariances
for observations one or two time periods apart are equal to ρσ2, and covariances for measurements greater than
two time period apart are equal to zero. That is
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where σ2 is the residual variance and ρ is the correlation between observations on the same subject.

Procedure Options
This section describes the options that are specific to this procedure. These are located on the Design tab. For
more information about the options of other tabs, go to the Procedure Window chapter.

Design Tab
The Design tab contains most of the parameters and options that you will be concerned with.

Solve For
Solve For
This option specifies the parameter to be solved for. When you choose to solve for Sample Size, the program
searches for the lowest sample size that meets the alpha and beta criterion you have specified for each of the
terms. The "solve for" parameter is displayed on the vertical axis of the plot.
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Test Statistic
Test Statistic Type
Specify the type of test you will use to perform the analysis.
Multivariate Test (Recommended)
The results assume that a multivariate Hotelling's T² will be used to analyze the data. This test requires no special
assumptions about the structure of variance-covariance matrix. Often, an AR(1) correlation model is used. The
denominator of the test is specific to the contrast. The error degrees of freedom is N-1. Maxwell and Delaney
(2003) list this as their test of choice.
In the case of cross-over data in which several different treatment orders are combined, we suggest that the ‘All
ρ’s Equal’ correlation model be used and the pattern of σ’s across time be set to ‘Equal.’
Univariate Test
Use a univariate F-Test to analyze the data. The error degrees of freedom is (N-1)(M-1).

Power and Alpha
Power
This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis,
and is equal to one minus Beta. Beta is the probability of a type-II error, which occurs when a false null
hypothesis is not rejected. In this procedure, a type-II error occurs when you fail to reject the null hypothesis of
equal means when in fact the means are different.
Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for power. Now,
0.90 (Beta = 0.10) is also commonly used.
A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be entered.
Alpha
This option specifies one or more values for the probability of a type-I error. A type-I error occurs when a true
null hypothesis is rejected. In this procedure, a type-I error occurs when you reject the null hypothesis of equal
means when in fact the means are equal.
Values must be between zero and one. Historically, the value of 0.05 has been used for alpha. This means that
about one test in twenty will falsely reject the null hypothesis. You should pick a value for alpha that represents
the risk of a type-I error you are willing to take in your experimental situation.
Note that this is a two-sided test.
You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.

Sample Size
N (Subjects)
Enter a value for the sample size (N), the number of individuals in the study. Each subject is measured 2 or more
times. You may enter a single value or a range of values. A separate power calculation will be made for each
value of N you enter.
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Examples
10 to 100 by 10
10 30 80 90
10, 30, 80, 90

Effect Size – Periods, Means, and Contrast
M (Periods)
Specify the number of periods. This is also the number of measurements made on each subject. These
measurements are made at the same time points or under the same general conditions.
Notes
• Exactly one value must be entered.
• The value must be an integer greater than 1. A reasonable range is from 2 to 10.
• This value must match the number of Means entered below.
• In this design, a particular treatment may be measured several times on each subject at different time points.
Means
These options specify the means under the alternative hypothesis, one for each time point. The test statistic tests
whether a contrast of these means is equal to zero. The contrast value ΣCiμi is tested against zero by the
hypothesis test. The statistical hypotheses are
H0: Contrast Value = ΣCiμi = 0
versus
Ha: Contrast Value = ΣCiμi ≠ 0.
The means represent the alternative hypothesis. They are not necessarily the means you expect. Rather, they
represent the size of the contrast value that you want to detect.
This option specifies how you want to enter the M means for the alternative hypothesis. Your choices are List,
Range, or Sequence.
Means = List
When this option is selected, a box appears to the right that lets enter a list of hypothesized mean values. Enter a
set of M hypothesized means, μi, one for each time point.
You should enter a set of means that represents the pattern and magnitude of the contrast you wish to detect. Enter
numbers separated by blanks or commas. If the number of means entered is less than M, the last mean entered
will be copied forward. If too many means are entered, the extra will be ignored.
Example 1
Suppose M = 3 and you have two treatments, A and B. Further, suppose A represents the control and B represents
a new treatment and that you want to be able to detect a difference between A and B of 10. If you were planning
on a design of BAB you could enter '10 0 10.' If you were planning on a design of ABB you would enter '0 10 10.'
Example 2
Suppose M = 4 and you have two treatments, A and B. Further, suppose A represents the control and B represents
a new treatment and that you want to be able to detect a difference between A and B of 10. If you were planning
on a design of BABA you could enter '10 0 10 0.' If you were planning on a design of AABB you would enter '0 0
10 10.'
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Example 3
Suppose M = 6 and you have three treatments, placebo (P), drug at low dose (L), and drug at high dose (H).
Further, suppose you want a sample size large enough to detect a difference between L and H of 10. You believe
that the low dose will perform about just a little higher than the placebo, say 3. If you were planning on a design
of PLHHLP you could enter '0 3 13 13 3 0.' If you were planning on a design of PLHPHL you would enter '0 3 13
0 13 3.'
Means = Range
Enter a range of values by specifying the first and the last. The other means will be generated equi-spaced
between these values.
Means = Sequence
Enter a set of means by specifying the first mean and a step-size (increment) to be added for each succeeding
mean.
K (Mean Multiplier)
Enter one or more values for K, the mean multiplier. A separate power calculation is conducted for each value of
K. In each analysis, all means are multiplied by K. In this way, you can determine how sensitive the power values
are to the magnitude of the means without the need to change them all individually.
Note that multiplying each mean by K results in the contrast value being multiplied by K. For example, if the
original means are 0, 1, and 2, setting this option to ‘1 2’ results in two sets of means used in separate analyses: 0,
1, and 2 in the first analysis and 0, 2, and 4 in the second analysis.
If you want to ignore this option, enter a one.

Effect Size – Contrast
These options specify the coefficients (Ci’s) of the contrast that you are using. Each coefficient is multiplied by
the corresponding mean in the mean-list above and then summed. The contrast value is ΣCiμi.
You can either specify a type of contrast and PASS will generate the coefficients for you, or you can select
Custom List and enter the coefficient values directly.
Contrast Coefficients = List
When this option is selected, a box appears to the right that lets enter a list of contrast coefficients. Enter a set of
contrast coefficients (Ci's) separated by commas or blanks. Each coefficient is multiplied by the corresponding
mean in the Means List above and then summed. The contrast value is ΣCiμi.
By definition, these coefficients must sum to zero. That is, ΣCi = 0. It is recommended that Σ|Ci| = 2.
If the number of items in the list is less than M, 0's are added. If the number of items in the list is greater than M,
extra items are ignored.
How to Generate the Coefficients
The coefficients are key to the accuracy of your results. One of the easiest ways to determine an appropriate
contrast is to imagine that the contrast is comparing the averages of two treatments.
Example 1 (M = 4)
Suppose M = 4 and there are two treatments. The treatment arrangement might be ABBA. An appropriate set of
contrast coefficients would be -1 1 1 -1. However, Σ|Ci| = 4. This should be 2. To adjust the coefficients so they
sum to 2, we adjust the negative coefficients so they sum to -1 and the positive coefficients so they sum to 1,
keeping their ratios the same. This this results the coefficients -.5 .5 .5 -.5.
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Example 2 (M = 5)
Suppose M = 5 and there are two treatments. The treatment arrangement might be BABAB. An appropriate set of
contrast coefficients would be -2 3 -2 3 -2. However, Σ|Ci| = 12. This should be 2. To adjust the coefficients so
they sum to 2, we adjust the negative coefficients so they sum to -1 and the positive coefficients so they sum to 1,
keeping their ratios the same. This this results the coefficients -.333 .5 -.333 .5 -.334.
Example 3 (M = 6, 3 Treatments)
Suppose M = 6 and there are three treatments. The treatment arrangement might be ABCACB. In this case, we
will need to make two sets of contrasts. These will be run separately.
To compare A with the average of B and C we could used '-2 1 1 -2 1 1.' Adjusting these values so that Σ|Ci| = 2
would result in '-.5 .25 .25 -.5 .25 .25.'
Next, to compare B with C, we would use '0 -1 1 0 1 -1.' Adjusting these values so that Σ|Ci| = 2 would result in '0
-.5 .5 0 .5 -.5.'
Contrast Coefficients = Linear Trend
A set of coefficients is generated appropriate for testing the alternative hypothesis that there is a linear (straightline) trend across the means. These coefficients assume that the means are equally spaced across time.
Contrast Coefficients = Quadratic
A set of coefficients is generated appropriate for testing the alternative hypothesis that the means follow a
quadratic model. These coefficients assume that the means are equally spaced across time.
Contrast Coefficients = Cubic
A set of coefficients is generated appropriate for testing the alternative hypothesis that the means follow a cubic
model. These coefficients assume that the means are equally spaced across time.
Contrast Coefficients = First vs Rest
A set of coefficients is generated appropriate for testing the alternative hypothesis that the first mean is different
from the average of the remaining means. For example, if there were four groups, the generated coefficients
would be -3, 1, 1, 1.

Effect Size – σ (Standard Deviation)
Pattern of σ’s Across Time
Specify whether the σi's vary across the measurement points or are the same.
Equal: σ = σ1 = σ2 = ... = σM
The σi's are constant across time. This assumption is required by the univariate F-test.
Unequal: σ1 ≠ σ2 ≠ ... ≠ σM
The σi's can vary across time. Care must be used in this case since the treatment arrangement can change the
results. Usually, if you have unequal variances, you will want to keep the σi's proportional to their means.
σ (Standard Deviation) – Equal Pattern
This is the between subject standard deviation of the response variable (Y) at a particular time point. It is assumed
to be the same for all time points. As a standard deviation, the number(s) must be greater than zero.
This represents the variability from subject to subject that occurs when the subjects are treated identically.
You can enter a list of values separated by blanks or commas, in which case, a separate analysis will be calculated
for each value.
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σ Button
You can press the σ button and select ‘Covariance Matrix’ to obtain help on estimating the standard deviation
from an ANOVA table.
Examples
1,4,7,10
1 4 7 10
1 to 10 by 3
σi’s (σ1, σ2, …, σM) – Unequal Pattern
Specify how you want to enter the M σi's. Your choices are List, Range, or Sequence.
σi’s (σ1, σ2, …, σM) = List (Unequal Pattern)
Enter a list of σi's in the box that appears to the right.
σi’s (σ1, σ2, …, σM) = Range (Unequal Pattern)
Enter a range of σi's by specifying the first and the last. The other σi’s will be generated between these values
using a straight-line trend.
σi’s (σ1, σ2, …, σM) = Sequence (Unequal Pattern)
Enter a range of σi’s by specifying the first and the step-size (increment) to be added for each succeeding σi.
h (σi Multiplier)
Enter a list of h values. A separate analysis is made for each value of h. For each analysis, the σi’s entered above
are all multiplied by h. Thus σ1, σ2, ..., σM become hσ1, hσ2, ..., hσM. Hence, using this parameter, you can
perform a sensitivity analysis about the value(s) of the standard deviation.
Note that the resulting values must all be positive, so all h’s must be greater than 0.
If you want to ignore this option, enter a 1.

Effect Size – ρ (Correlations Among Periods)
Pattern of ρ’s Across Time
Specify the correlation structure of the covariance matrix. The number of diagonal elements in the matrix is equal
to M.
Possible options are
•

All ρ’s Equal
All variances on the diagonal of the within-subject variance-covariance matrix are equal to σ2, and all
covariances are equal to ρσ2.

1

ρ
ρ
Σ = σ 2
ρ


ρ


ρ
1

ρ
ρ

ρ
ρ

ρ





ρ

ρ

1

ρ  ρ

ρ  ρ
ρ  ρ

1  ρ

 

ρ  1  M ×M


567-10
© NCSS, LLC. All Rights Reserved.

PASS Sample Size Software

NCSS.com

M-Period Cross-Over Designs using Contrasts
•

AR(1)
All variances on the diagonal of the within-subject variance-covariance matrix are equal to σ2, and the
covariance between observations t time periods apart is ρtσ2.
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Banded(1)
All variances on the diagonal of the within-subject variance-covariance matrix are equal to σ2, and the
covariance between observations one time period apart is ρσ2. Covariances between observations more than
one time period apart are equal to zero.
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Banded(2)
All variances on the diagonal of the within-subject variance-covariance matrix are equal to σ2, and the
covariance between observations one or two time periods apart are ρσ2. Covariances between observations
more than two time periods apart are equal to zero.
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ρ (Correlation)
This is the correlation, ρ, between measurements on the same subject taken at the first and second time points.
At least one value must be entered. If multiple values are entered, a separate analysis is performed for each value.
Range
0 < ρ < 1 (negative values are not used). A value near 0 indicates low correlation. A value near 1 indicates high
correlation.
Recommended
The value of this parameter depends on time or location pattern at which measurements are taken. In their book on
sample size, Machin and Campbell comment that values between 0.60 and 0.75 are typical. Some authors
recommend using 0.2 when nothing is known about the actual value.
Examples
0.5
0.5 0.6 0.7
0 to 0.9 by 0.1
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Example 1 – Determining Sample Size
Researchers are planning a study of the impact of a new drug on heart rate. The want to investigate three
treatments: placebo (P), low dose (L), and higher dose (H) of the new drug. They decide to use a 3x3 cross-over
design with six possible treatment sequences: PLH, PHL, HPL, HLP, LPH, and LHP. They will assign an equal
number of subjects to each sequence. Hence, the final sample size will be the next multiple of six above the N
found by PASS. For example, and N of 32 would be rounded up to 36.
They anticipate little difference between the placebo and the low dose. However, they expect that the high dose
will reduce the heart rate about 10%. They decide to use the mean values of 80, 80, and 72. The contrast that they
will use will be 0.5, 0.5, -1.0 for the treatment sequence PLH. This compares the average of the placebo and the
low dose to the high dose.
Similar studies have found a standard deviation of 15. To allow for a sensitivity analysis of the standard deviation,
they will use three standard deviations: 13, 15, and 17.
The researchers assume that all correlations among the measurements at different time points within a subject will
be equal to 0.5. To allow for a sensitivity analysis of the correlation, they will use three correlations: 0.4, 0.5, and
06.
They decide to use the multivariate test statistic.
The test will be conducted at the 0.05 significance level. What sample size is necessary to achieve 90% power
over a range of possible means and standard deviations?

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the M-Period Cross-Over Designs using Contrasts procedure window by expanding Means, then
Cross-Over (Higher-Order) Design, then Test (Inequality), and then clicking on M-Period Cross-Over
Designs using Contrasts. You may then make the appropriate entries as listed below, or open Example 1 by
going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Sample Size
Test Statistic Type .................................. Multivariate
Power ...................................................... 0.90
Alpha ....................................................... 0.05
M (Periods) ............................................. 3
Means ..................................................... List
Means – List Values ............................... 80 80 72
K (Means Multiplier) ................................ 1
Contrast Coefficients .............................. List
Contrast – List Values............................. 0.5 0.5 -1
Pattern of σ’s Across Time ..................... Equal
σ (Standard Deviation) ........................... 13 15 17
Pattern of ρ’s Across Time ..................... All ρ’s Equal
ρ (Correlation) ......................................... 0.4 0.5 0.6
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Annotated Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results for an M-Period Cross-Over Design using Contrasts
Test Type: Multivariate T² test
Means:
80 80 72
Contrast:
0.5 0.5 -1
ρ's:
All Equal
σi's:
All Equal

Power
0.9004
0.9025
0.9054
0.9065
0.9031
0.9102
0.9022
0.9035
0.9053

Subjects
N
27
23
19
36
30
25
45
38
31

Time
Points
M
3
3
3
3
3
3
3
3
3

Mean
Mean
Multiplier Contrast
K
Σcμ
1.00
8.000
1.00
8.000
1.00
8.000
1.00
8.000
1.00
8.000
1.00
8.000
1.00
8.000
1.00
8.000
1.00
8.000

Std
Dev
σ
13.000
13.000
13.000
15.000
15.000
15.000
17.000
17.000
17.000

Corr
ρ
0.400
0.500
0.600
0.400
0.500
0.600
0.400
0.500
0.600

Alpha
0.050
0.050
0.050
0.050
0.050
0.050
0.050
0.050
0.050
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Report Definitions
Power is the probability of rejecting a false null hypothesis.
N is the number of subjects. Each subject is measured at two or more time points.
M is the number of time points at which each subject is measured.
K is the effect size multiplier. The original means are all multiplied by this value, resulting in a
corresponding change in the effect size.
Σcμ is the linear combination of the means and the contrast coefficients. This represents the difference among
the means that is being tested.
σ is the standard deviation across subjects at a given time point. It is assumed to be identical for all time
points.
ρ is the (auto)correlation between observations made on a subject at the first and second time points.
Alpha is the probability of rejecting a true null hypothesis.
Summary Statements
A 3-period cross-over design is analyzed using a contrast. A sample of 27 subjects achieves 90%
power to detect a contrast using a multivariate T² test at a 0.050 significance level. The
standard deviation across subjects at the same period is assumed to be 13.000. The pattern of
the covariance matrix is to have all correlations equal with a correlation of 0.400 between the
first and second time point measurements. The value of the contrast applied to the hypothesized
means is 8.000.

This report gives the power for each value of the other parameters. The definitions are shown in the report.
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Plots Section

The chart shows the relationship among N, σ, and ρ when the other parameters in the design are held constant.

The chart shows a 3D view of the relationship among N, σ, and ρ when the other parameters in the design are held
constant.
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Example 2 – Validation using Hand Calculations
We will compute the following example by hand and then compare that with the results that PASS obtains. Here
are the settings:
Test Statistic

Multivariable T2

M

3

Means

1, 2, 3

K

1

Coefficients
σ

-2, 1, 1
5

ρ

0.5

Covariance Type
Alpha

AR(1)
0.05

N

100

Using these values, we find the following
C’μ
C’ΣC

3
100

Δ

0.3

F 0.95,1,99

3.9371169

Non-Centrality
Power = 0.8439

9

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the M-Period Cross-Over Designs using Contrasts procedure window by expanding Means, then
Cross-Over (Higher-Order) Design, then Test (Inequality), and then clicking on M-Period Cross-Over
Designs using Contrasts. You may then make the appropriate entries as listed below, or open Example 2 by
going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Power
Test Statistic Type .................................. Multivariate
Alpha ....................................................... 0.05
N (Subjects) ............................................ 100
M (Periods) ............................................. 3
Means ..................................................... List
Means – List Values ............................... 1 2 3
K (Means Multiplier) ................................ 1
Contrast Coefficients .............................. List
Contrast – List Values............................. -2 1 1
Pattern of σ’s Across Time ..................... Equal
σ (Standard Deviation) ........................... 5
Pattern of ρ’s Across Time ..................... AR(1)
ρ (Correlation) ......................................... 0.5
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Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results for an M-Period Cross-Over Design using Contrasts
Test Type:
Multivariate T² test
Means:
123
Contrast:
-2 1 1
ρ's:
AR(1)
σi's:
All Equal
Subjects
Power
N
0.8439
100

Time
Points
M
3

Effect Size
Mean
Multiplier Contrast
K
Σcμ
1.00
3.000

Std
Dev
σ
5.000

Auto
Corr
ρ
0.500

Effect
Size
∆
0.300

Alpha
0.050

Note that PASS’s power of 0.8439 matches what we obtained above by hand.
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